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Introduction to the Archive Configuration, Archive, and Restore Tools

The Archive Configuration Tool allows you to configure the system for archiving account data.
Configuration includes specifying the archive server, archive database, and which tables a user can
archive, view, and purge. Configure the system before attempting to archive or restore account data.

The Archive Tool allows you to archive account data to increase performance in your production
database by removing most of the data for older, returned accounts. Archiving moves most account
data from your Latitude database to an archive database that you or a Latitude by Genesys
representative created. The system doesn't archive all data it uses some data to open the account in the
Work Form and some data for financial accounting.

We recommend that you store the archive database on a different server than your Latitude database to
increase performance on the production server. Since the archived data is rarely used, you can store it
on a server with lower performance requirements, which can result in lowered data storage costs. If
your company uses more than one production database, set up a separate archive database for each
production database.

The Restore Tool allows you to restore archived account data. Restoring moves account data from the
archive database to your Latitude database. Once you restore account data, you can view it as you
normally would in the Work Form in Latitude.
Archive and restore permissions
The system requires the following permissions to allow you to archive and restore account data:

e Access Archive/Restore Functionality

e Enable Archive of Account Data

For more information about these permissions, see "Archive Permissions and Policies" in the Latitude
documentation.

Help Overview

Archive Configuration, Archive, and Restore Tools help provides you with information for using the
Archive Configuration, Archive, and Restore Tools. To locate and view a topic, use the table of contents,
index, and search features.

To open help

Open the "\\Program Files (x86)\Interactive Intelligence\Interaction Collector\Documents" folder and
then double-click ArchiveAndRestore.chm.

Tip: To adjust the width and height of the window or its panes, click the edge of the window or pane
and drag it up or down, left or right.

1. Toolbar: Allows you to hide or show tabs and the Navigation pane, move forward and backward
through topics, and print the currently displayed topic.

2. Tabs: Displays the following:

Contents: Displays the table of contents. To display a topic in the Content pane, expand a book
and then click the link.



Archive and Restore Tools Printable Help

Index: Displays the index. To display a topic in the Content pane, type a keyword or phrase in the
box (or scroll through the list) and then click the link in the list.

Search: Displays the search feature. To display a topic in the Content pane, type a keyword or
phrase in the box and then press Enter. In the search results, click the link.

Glossary: If available, displays a list of terms and their definitions. To display a definition, click the
term.

3. Breadcrumbs: Displays your current location within the help system. When you click a
breadcrumb, the related topic displays.

4. Content toolbar: Displays an option to send feedback through an email message to Latitude by
Genesys Documentation.

5. Content pane: Displays the contents of a topic. To view the Content pane menu, right-click in
the Content pane.

Search feature

You can use the search feature to search for topics that contain words or phrases that you specify. You
formulate a search query following a specific set of rules. You can include wildcard expressions, Boolean
operators, and nested expressions in your search query. A list of topics that match your search criteria
appear in the search results. When you click a topic title in the search results, the content of that topic
appears in the Content pane.

Search syntax
The basic rules for formulating search queries are:
e Searches are not case-sensitive, meaning you can type uppercase or lowercase characters.

e You cannot search for a single character or the following reserved words: an, and, as, at, be, but,
by, do, for, from, have, he, in, it, not, of, on, or, she, that, the, there, they, this, to, we, which,
with, you.

e The search engine ignores punctuation marks and special characters such as @#5%"&()=+[]\.

e Enclose phrases and terms that include a period (such as a file name with an extension) in
double quotation marks.

Wildcard expressions

Wildcard expressions allow you to search for one or more characters using a question mark or asterisk.
A question mark represents a single character, while an asterisk represents one or more characters.

Search for... Example [Result

Topics with text that starts with one or
more specified characters and ends in |og or log*
any character or number of characters

Returns all topics with text that starts with the
specified characters (for example, log, logon, logging).
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Search for... Example [Result
Topics with text that starts with the . .
oo . Returns all topics with text that has any character
specified characters, has a single .
“haracter that can be anvthing. and 32757 where you placed the question mark (for example,
\ 2 YyEning, 32757 returns 32257, 32457, and 32857).
ends in the specified characters
. . Returns all topics with both account and status, but
Topics that contain all the words . . -
e account |not necessarily as a phrase or in the order specified.
specified, in any order or placement . o
o . status For example, the search returns topics with "the
within the topic v "
account status..." or "the status of the account...
. . o . Returns all topics with account status as a phrase. For
Topics that contain the specified account . o
. lexample, the search returns topics with "the account
phrase status

status..." but not "the status of the account..."

Boolean operators

Boolean operators (AND, OR, NOT, NEAR) allow you to create a relationship between terms. If you don't
specify an operator, the system uses AND by default.

Search
Example Result
for...
Returns all topics with both account and status, but not necessarily as a phrase or
account AND|, o : -
AND ctatus in the order specified. For example, the search returns topics with "the account
status..." or "the status of the account..."
account OR . . .
OR ctatus Returns all topics with either account or status, or both.
account NOT . .
NOT Returns all topics with account but not status.
status
dccount . S
NEAR Returns all topics where account is within eight words of status.
NEAR status

Nested expressions

Nested expressions allow you to perform complex searches. For example, queue AND ((collector OR
clerical) not supervisor) finds topics containing queue and collector but not supervisor, or containing
queue and clerical but not supervisor. As with mathematical expressions, the system evaluates
expressions in parentheses first. If there is no parenthesis, the system evaluates the expression from left
to right. For example, queue NOT (clerical OR supervisor) finds topics containing queue but not clerical
or supervisor. Queue NOT clerical OR supervisor finds topics containing queue but not clerical, or topics

containing supervisor.
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Archive Configuration Tool

Archive Configuration Tool

Use the Archive Configuration Tool to specify the configuration for archiving account data.

Log on to the Archive Configuration Tool

Use the Latitude Login dialog box to log on to the Archive Tool.
To log on to the Archive Tool

1. Click Start > All Programs > Interactive Intelligence > Interaction Collector > Archive Tools >
Archive Configuration Tool. The Latitude Login dialog box appears.

iy Latitude Login

User Name: ||

Password: |

Database: |D9fau|t Instarce j

[T Login using Windows authentication

2. Inthe User Name box, type your Latitude user name.

3. Inthe Password box, type your Latitude password. As you type your password, periods display
instead of the typed characters.

Note: To log on using Windows authentication, select the Log in using Windows authentication
check box and provide your Windows user name and password.

4. Click Okay. The Latitude Archive Configuration Utility window appears.
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. Latitude Archive Configuration Utility

File  Help
Archive Server Archive User |<HECIUirEE|>
Archive Databaze |<F|equired> Y T — Ixxxxxxxxxx
T ableM ame | JoinCalumn FarentT able ParentColumn Archive Wiewable 1=l
I debtors humber master humber I I
Payhistany nurmber rasker nurmnber r r
notes nurmber master nurmber v v
migcextia hummber master hummber "2 I~
extradata number master number v vl 1.
Debtordttorneys accountid master rurmber 2 =
DebtorB ankinfo acchd master number v ¥
Garnishment accountid master nurmber "l v
PDLC number master number v vl _ILI
1| | »
ﬂ |Ipdate | Cancel I
li Firsk kime configuration

Specify Configuration for Archiving Account Data

Use the Latitude Archive Configuration Utility window to specify the configuration for archiving account

data.
To specify configuration for archiving account data

1. Open the Latitude Archive Configuration Utility window.
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. Latitude Archive Configuration Utility

File  Help
Archive Server Archive User |<HECIUirEE|>
Archive Databaze |<F|equired> Y T — Ixxxxxxxxxx
T ableM ame | JoinCalumn FarentT able ParentColumn Archive Wiewable 1=l
I debtors humber master humber I I
Payhistany nurmber rasker nurmnber r r
notes nurmber master nurmber v v
migcextia hummber master hummber "2 I~
extradata number master number v vl 1.
Debtordttorneys accountid master rurmber 2 =
DebtorB ankinfo acchd master number v ¥
Garnishment accountid master nurmber "l v
PDLC number master number v vl _ILI
1| | »
ﬂ |Ipdate | Cancel I
li Firsk kime configuration

Archive Server: Server where the archive database resides.

Archive Database: Name of the database to store archived account data.

Archive User: User ID for accessing the archive database.

Archive Password: Password for accessing the archive database.

Archive: If selected, the system archives the data in the corresponding production table.
Viewable: If selected, you can view the archived data in the Archive Tool.

Archive: If selected, the system purges the data in the corresponding production table after
archiving the data.

2. Complete the information and then click Update.

Import Table Definitions

Use the Import Table Definitions dialog box to import table definitions into the archive table. The
import process overwrites the existing archive table definitions.

To import table definitions

1. Inthe File menu, click Import Table Definitions. The Import Table Definitions dialog box
appears.
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‘.Irnpuﬂ. Table Definitions B

'k:-'\-\ J I = Usars » barbara.martin = By Documents « Latibude = M|ﬁathlattu:le m

Oroanize = Mew folder =+ [ g
21 mame ¢ ||:uai:emu-:ifud Typa j

" Favorites
B Deckiop */| ArchiveTabieR slationship FIU92016 B:54 AW MWL Dacument
B Dovanloads

= Recant Placas

i Libraries
&| Documerts
@' Music
e Fichures
B videos

‘M Computer
& Local Disk (C:
v—r—— | | s

- mam e e 3 e

Fill narme: |lrchiveTableRelationship =] ML Files =l

Open | Cancel 1

P

2. Inthe Name column, click the name of the import file and then click Open. A confirmation
dialog box appears.

Latitude Archive Configuration Utility - Import Table Definitions E

fre o sure you want to ovengribe the current table definition

JB with the conteris of
"CUsersibarbara. martin|DocumentsiLatitudel ArchiveT ableRelati

orship. zml"

f Yes I ] Cancel

3. Click Yes.

Synchronize the Archive Schema

Use Synchronize Archive Schema feature to synchronize the production database schema to the archive
database. Use this feature to ensure that your archive database has the latest changes to the production

database.
To synchronize the archive schema

1. Inthe File menu, click Synchronize Archive Schema. A progress dialog box appears. When
synchronization is complete, a notification dialog box appears.
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Fireshed Synchionizing archive databace tables.

100 % completed
FlLatitude Archive Configuration Utility x| i

lﬂ Process completed successfully,

[ x 1]
m

2. Click OK.

Export Table Definitions
Use the Export Table Definitions dialog box to export the table definitions in the archive table.
To export table definitions

1. Inthe File menu, click Export Table Definitions. The Export Table Definitions dialog box
appears.

& Export Table Definitions

‘:\ J"x J' | i = Users z barbara.martin = My Documerks = Latibude 2 ml Search Latiude v

=l Recent Places 21 Name - 1 Diate modified Type

‘= hrchiveTableR elationship 7192016 B:54 AM WML Dooument

"..: Mugic
| Pichures

B Wideos

18 Computer
Sk Local Disk{(C:)
=) ovo orive (D2 GRE
A2 oo ey =41

Fie nama: [.nrd'i'-'aTabla-RElatbr'shlpj

Save as bype |5-:r-|_ Files

1|71

= Hide Fl:HcrsI Save | Cancel I

o

2. Inthe File name box, type a name for the export file and then click Save. The system exports the
table definitions to the specified file.

View Archive History

Use the View Archive History dialog box to view the history of archive actions, such as configuration
changes and archiving of account data.

10
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To view archive history

1. Inthe File menu, click View Archive History. The View Archive History dialog box appears.

K. ¥iew Archive History = | O] =}

File
Fiom B1%2015 x| To [ 71372006 2] Action [A = # muses oo |
Date | zer Achon Dezcriphion
] FA1952016 10:23 AM 2 Iritialy created archive ralstionzhip
7M92ME10:234M gs 2 Anchive relationzhip updated
: TA920ME 357 4 g 2 Irihaly created archive relstionship
TAR2MNE IS5 AM | gs 2 Irilialy created aichive ielationship
TA972001E 354 AW gz 2 Irilialy created archive elstionzhip
TAY2NE 24 AM | o= 2 Initialy crested archiee relatonship
TASEITIAM | gs 2 Initialy created archive relabionship
TASZMEAST AM g 2 Aachive tables synchronized
TAS20EE 44 AWM gz a Accounts Tmvabds: DProcessed 1Elapsed Time [hk:mmss
TAY2NMEEA4AM o g SELECT TOP 100 PERCEMT [Mastes] [number|FROM [doo)
TNANE2IPM | g 1 Accounts: Tirvalids: DFsocessed: 1Elapsed Time (hhmm:ss
THB2ME235PH g 16 SELECT TOP 100 PERCEMT [Mastes] [number]FROM [dbo]
 INB2ME1SEPM | gs 8 Accounts Tinvalids: DFvocessed: TElapsed Time [bhimmcss
TAS201E 156 PM | ge g SELECT TOP 100 FERCENT [Master] [rumber|FROM [doa)
®

Bl

From: Start date for which to display information.
To: End date for which to display information.
Action: Action for which to display information.

All Users: If selected, displays information for all users. If cleared, displays information for the
current user only.

2. Complete the information and then click GO. The system displays the archive history for the
specified criteria.

Archive Tool

Archive Tool

Use the Archive Tool to archive data for accounts that you specify. Only accounts with a "999" queue
level (returned) are eligible for archive.

Log on to the Archive Tool

Use the Latitude Login dialog box to log on to the Archive Tool.

To log on to the Archive Tool

1. Click Start > All Programs > Interactive Intelligence > Interaction Collector > Archive Tools >
Archive Tool. The Latitude Login dialog box appears.

11
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Select Accounts to Archive

2.
3.

i Latitude Login

User Name:
Passwoird:

Database:

|Defau|t Instance j

[T Login using Windows authentication

Cancel

In the User Name box, type your Latitude user name.

In the Password box, type your Latitude password. As you type your password, periods display
instead of the typed characters.

Note: To log on using Windows authentication, select the Log in using Windows authentication
check box and provide your Windows user name and password.

4. Click Okay. The Latitude Archive window appears.

I Latitude Archive M=l E3

File  Help

Select Accounts | Pravieys Hesults]

:] Clear | 1} | Open HSave P | Count @ Fun

Dbt Forwarding
Debt Purchasing
Debtor Demographics
Dialers

| Early Stage Data

| Latitude Fusion

| Money Buckets
| Patient Information
1 Payments
| PorticlioCantacts
| Porticlios
Post Dates
Promizes
Restrictions
[# [ Witk Strategies

%F Blank Literal Condition

Services_|dInfo_Bankruptcy

[~ Exchede Duplicate Recards

[T Masimum Records o0 3;
LR B Al =13k

Drag and ¢ Lj

=

¥ Conditions 2]
7R 4 ¥ 2Dl @@

Account iz not archived ;i

and Account has been closed and returned
and Meetz Returned Date Policy of -1 Month: Ago

<]
N4 & il

rag and dhop &

-

-

Exscute
|gs | o7r18y16 01:00:32 PM

Use the Select Accounts tab in the Latitude Archive window to select the accounts to archive.

12
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Note: These instructions are for creating a query. You can also open an existing query to select
accounts. For more information about working with queries, see "Queries" in the Latitude
documentation.

To select accounts
1. Inthe Latitude Archive window, click the Select Accounts tab.

E Latitude Archive !E n

File  Help

Select Accounts | Freview Fesults |

j Clear | |4 | Open H Save | 2, | Count @ Fiun

iy ‘_ iﬁﬂmur\ts [ Euchede Duplicate Recaids
- ! -
5[] Champion Challenger ™ Maximum Records a0 e
5 i comen
@[ Dabt Forwarding
[ . Debt Purchazing g . J} | [7== 1&] -
[ {7 Debtor Demographics : . .
a1 (] Dialers Drag and dhop new columns onfo fhe suface Li
%17 Early Stage Data
+-[7] Latihude Fusion .
+-17 Legal .
5 1 Letors
+-17] Money Buckets L . R .
<[] Patient Information 4 g o J—/L _t| al | § @ @
T: - Pa,"mefms Account iz not archived ;i
+_ . Forlfd!UE’Unl‘mts and Account has been closed and returned
T Portfolios and Meet: Retumed Date Policy of -1 Monthe Ago
I Post Dates
Promizes ;j
E- [ Restrictons
- Senvices_idnio_ Barknpicy
# Wtk Strategies f 4 B | ¥ o=
%F Blank Literal Condtion g L g J} | ' l-!'i
Dirag and dhop naw columns onfo fhes suriaca ;i
Exacute I

|'gs | o7j18f16 01:00:32 P
The system sets three conditions by default; however, you can delete them.
2. To exclude duplicate records from the query results, select Exclude Duplicate Records.

3. To limit the query results to a specific number of records, select Maximum Records and then, in
the box, type the maximum number of records to include in the results.

4. In the Select Columns pane, do the following as necessary to specify the data columns to include
in the query results:

a. Drag and drop one or more data items into the Select Columns pane.
b. Arrange the order of the columns.

5. Inthe Conditions pane, do the following as necessary to specify the query conditions:

a. Drag and drop one or more conditions into the Conditions pane.
b. Arrange the order of the conditions.
C. Group conditions for evaluation.
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6. Inthe Order pane, do the following as necessary to specify the sort order for the data returned
in the query results:

a. Drag and drop one or more data items to use to sort the query results into the Order pane.
b. Arrange the order of the data items.
C. Click the data item and then click the Ascending or Descending icon.

7. To count the number of records that match the selection criteria, in the toolbar, click Count. The
results appear in the Query Designer dialog box. Click OK.

8. To save the query, do the following:

a. In the toolbar, click Save. The Save Query Dialog box appears.
Save Query Dialog E‘
Look In: |My Queries x Dedete | % Export To Fle
MHame Date Created |
Accounts is Parent 12/14f2012
Account Status is Open 12/18/2012
Query Name: |

b. Inthe Query Name box, type a name for the query and then click Save.

Tip: To overwrite an existing query, in the Name column, click the query to overwrite and then
click Save.

9. Click Run. The query results appear on the Preview Results tab.

Archive Account Data

Use the Preview Results tab in the Latitude Archive window to review the accounts selected for archive,
and then archive the data for those accounts.

To archive account data

1. After running a query, in the Latitude Archive window, click the Preview Results tab. The results
appear in the data grid.

14
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[ Latitude Archive !E E
File  Help
Select Accounts  Preview Resuls |

I- rag & column header here to group by that column
fir!
Smith, Patnca 123 Main Street J& 32256
1234 0000000 Rolirs, Kathy 56 Marth Charle,, COLUMBL OH 43223
1244 0000000 JOWES, PATRI.. 5E3 BLAKE RO.. APTK COLUMBLS OH 43226
1327 Q000000 HILAND. JEMHI..
1355 0000000 RIDODLE, KATHY 233 MANDY RO JACKSOMVILLE  FL 32256
1710 EXCHDESE. TERWILLEGER... 628 E GLASS A JACKSOMVILLE  FL 32256
7 EXCHDESE KOSTELSK], JOW 1080 TREELINE.. JACKSONVILLE - FL 32256
mz EXCHDESK HILTOM, CARRIE 2180 KMIGHTS. JACKESONVILLE  FL 32256
1713 EXCHDESE MAR, SHANE 271E RIVERVIE - JACKSOMVILLE  FL 32256
1714 EXCHDESE. STEFAND. FRA_ PO BOX 2204 JACKSONVILLE  FL 32256
1715 EXCHDESK HEYER, MOLLY 124 LARCHMO,, JACKSONVILLE  FL 32256
1HE ExCHDESE POLITO, AMGIE 311 CENTER 5T JACKSOMVILLE  FL 2256
177 EXCHDESE KING, ERICK, 1312 WEBSTER.. JACKSONVILLE  FL 32256
btk EXCHDESK GAY, PAMELA BDS LOWRY AVE JACKSONVILLE  FL 32256
1719 EXCHDESE HIMES, QUINTIN 7338 W 7TH 92.. JACKSOMVILLE  FL 32256
1740 EXCHDESE GERBER, CARL.. 147 WALMUT 5. JACKSOMNVILLE  FL 32256
17 EXCHDESE MAMTOM, DEB.. 52 ELDERBERR.. JACKSONVILLE  FL 32256
1742 EXCHDESE WILSOM, TIM 178 BEREAL DR JACKSOMVILLE  FL 32256
1743 EXCHDESE. MEYERS, DOM.. 111 MAGNOLIA JACKSOMVILLE  FL 32256
1744 EXCHDESK WASHINGTOM,.. 965 GREEMTRE.. JACKSONVILLE  FL 32256
j:ﬁ_l EXCHDESK LANDOM, COO.. 310 CHARLES . JACKSOMVILLE  FL 32256 _l_v|
4 »
Execube
| Preview: Completed successfully. |gs | 07/18/1601:14:19FM

The columns that appear are based on the ones you specified when you selected accounts.
Click Execute.

In the confirmation dialog box, click Yes. The system archives data for the accounts and then
displays a notification dialog box.

Click OK.
If errors occur during the archive, click the Exceptions tab.

[ Latitude Archive M= E3
File  Help
" Select Accounts | Preview Results Exceptions |

'Z rag a colurmn header here to group by that column

FileMumber Message

ve functionaity iz mot enabled

Execute

| | los | 0718/16 01:51:22 PM

Note: To print or save the exceptions to a file, use the Print Exceptions or Save Exceptions
option in the File menu.

15
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View Archived Data
Use the Latitude Archive View File Number window to view archived data for an account.
To view archived data

1. Inthe File menu, click View Archived Data. The Archive Data View dialog box appears.

Archive Data Yiew

Eribed the file nomber for the archived data vou

would like to view,
Cancel |

2. Inthe box, type the file number of the account to view and then click OK.

i ruamber c created uzerl achian result commert IzPmeate Lh‘d:reg
10192007 i Paid Us 100.00

1514 100328 10132007 55 B A Sialus Changed.. [m] 10413/
1819 100328 10/19/2007  nan co (0] Overpapment fu, @ 1019
1926 100328 10192007 S5 [EEE (R Paid Us Trarcher.. 'IEL"'IQJ'E
5168 100328 1142872007 man *iHbt et Apcount Fetuine.. E] 114287
47185 100328 LNE  02/12/2009  SYSTEM  LIMK MEW This account link.. [=] e el
54231 100328 06A03/2008  nan ARCHY 0K Aocount has bee., 0E/03/
54394 100328 0E/04/2005 nan RSTOR Ok Account haz bee.. [m] DE/044)
< 2

File: Number: 100E28

3. Click the tabs to view the data.

Restore Tool

Restore Tool

Use the Restore Tool to restore archived account data to your Latitude database.

Log on to the Restore Tool
Use the Latitude Login dialog box to log on to the Restore Tool.
To log on to the Restore Tool

1. Click Start > All Programs > Interactive Intelligence > Interaction Collector > Archive Tools >
Restore Tool. The Latitude Login dialog box appears.

16
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iy Latitude Login

User Name: ||

Password: |

Database: |Defau|t Instance j

[T Login using Windows authentication

2. Inthe User Name box, type your Latitude user name.

3. Inthe Password box, type your Latitude password. As you type your password, periods display
instead of the typed characters.

Note: To log on using Windows authentication, select the Log in using Windows authentication
check box and provide your Windows user name and password.

4. Click Okay. The Latitude Archive Restore window appears.

Select Accounts to Restore

Use the Select Accounts tab in the Latitude Archive Restore window to select the accounts to restore.

17
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Note: These instructions are for creating a query. You can also open an existing query to select
accounts. For more information about working with queries, see "Queries" in the Latitude
documentation.

To select accounts

18

1.

In the Latitude Archive Restore window, click the Select Accounts tab.

The system sets one condition by default.
To exclude duplicate records from the query results, select Exclude Duplicate Records.

To limit the query results to a specific number of records, select Maximum Records and then, in
the box, type the maximum number of records to include in the results.

In the Select Columns pane, do the following as necessary to specify the data columns to include
in the query results:

Drag and drop one or more data items into the Select Columns pane.

Arrange the order of the columns.

In the Conditions pane, do the following as necessary to specify the query conditions:
Drag and drop one or more conditions into the Conditions pane.

Arrange the order of the conditions.
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C. Group conditions for evaluation.

6. Inthe Order pane, do the following as necessary to specify the sort order for the data returned
in the query results:

a. Drag and drop one or more data items to use to sort the query results into the Order pane.
b. Arrange the order of the data items.
C. Click the data item and then click the Ascending or Descending icon.

7. To count the number of records that match the selection criteria, in the toolbar, click Count. The
results appear in the Query Designer dialog box. Click OK.

8. To save the query, do the following:

a. In the toolbar, click Save. The Save Query Dialog box appears.
Save Query Dialog E'
Look In: |My Queries x Delete | 5 Export To Fe

Mame Date Created |

Accounts is Parent 12/14f2012

Account Status is Open 12/18/2012

Query Name: |

cre =]

b. Inthe Query Name box, type a name for the query and then click Save.

Tip: To overwrite an existing query, in the Name column, click the query to overwrite and then
click Save.

9. Click Run. The query results appear on the Preview Results tab.

Restore Archived Account Data

Use the Preview Results tab in the Latitude Archive Restore window to review the accounts selected for
restoring, and then restore the data for those accounts.

To restore archived account data

1. After running a query, in the Latitude Archive Restore window, click the Preview Results tab.
The results appear in the data grid.

19
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E. Latitude Archive Restore Hi=lE
Fila  Help
Select Accounts  Preview Results |

Crag a column header here to group by that column

Sheetl

123 Main Streat

Street2

_______ Smith, Patiica

JACKSONVILLE FL

Eucl.l.el

[ T lgs | 07/18/16 02:30:41 PM

The columns that appear are based on the ones you specified when you selected accounts.

Click Execute.

In the confirmation dialog box, click Yes. The system restores archived data for the accounts and
displays a notification dialog box.

Click OK.

If errors occur during the restore, click the Exceptions tab.

E Latitude Archive Restore

File  Help
'Ealacthccnmtﬂ Freview Resuts  Exceptions |

rag a colurmn header here to group by that colurn

FileMurnber Mezsage Achan

i Error creating datatable from sml SmiException] Roob element & missingg - Restore

[ -1 Errar generating the restoee table list from the aichive database [MullReferencefxcept., Festore
{12323 ERROR: Logim faiked for uzer |30 0MAINAE asbara M arkey’ Restore

E wecute

| [gs | 07/18/16 02:38:40 PM

Note: To print or save the exceptions to a file, use the Print Exceptions or Save Exceptions
option in the File menu.
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